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1: Outlook Training
The tasks function of Microsoft Outlook is a way to keep track of daily, weekly, monthly and even yearly "to do" items.
You can use tasks to help remind you of once-in-a-while tasks that you must get done, or recurring tasks that happen all
the time.

Getting to Know Outlook Introduction Outlook is a personal information manager included in the Microsoft
Office suite, which is commonly used in the workplace. While Outlook is perhaps best known as a tool for
sending and receiving email messages, it also includes powerful features for managing calendars, contacts, and
tasks. Microsoft also offers a free webmail service through Outlook. While they share some functionality,
Outlook. Visit the Outlook preview page from Microsoft to learn more. Because of these robust productivity
features, Outlook is often used in many offices and workplaces to help employees communicate, manage their
time, and organize meetings. This tutorial will cover the basic features of Outlook , including how to use the
Mail, Contacts, and Calendar views. The main change is the addition of the Ribbon, which appears in all
Office applications. Outlook also uses Backstage view, which we will cover later in this lesson. Click the
buttons in the interactive below to become more familiar with the Outlook interface. Ribbon The Ribbon
contains all the commands you will need to perform common actions in Outlook. It has multiple tabs, each
with several groups of commands. The commands on the Ribbon will change depending on which view you
select in Outlook. By default, it shows the Check Inbox and Undo commands. To add more commands, click
the drop-down arrow and then select the desired command s from the menu. The Mail view is selected by
default whenever you open Outlook. Click the arrow to expand the To-Do Bar. Navigation Pane Every view
uses the Navigation pane to display navigational options. In this example, the navigation pane is displaying
options for the Mail view. Zoom Slider You can use the zoom slider to control the size of the content in the
View pane. View Pane The content for the selected view will appear in the View pane. In this example, the
View pane is displaying content from the Mail view. The Ribbon The tabbed Ribbon system was introduced in
Outlook to replace traditional menus. The Ribbon contains multiple tabs, each with several groups of
commands. You will use these tabs to complete the most common tasks in Outlook, such as composing an
email, scheduling a meeting, or adding a contact. The commands on the Ribbon will change depending on
which view you have selected: Mail, Calendar, Contacts, or Tasks. The Ribbon To minimize and maximize
the Ribbon: The Ribbon is designed to respond to your current task, but you can choose to minimize the
Ribbon if you find that it takes up too much screen space. Click the arrow in the upper-right corner of the
Ribbon. Minimizing the ribbon The Ribbon will be minimized. To maximize the Ribbon, click the arrow
again. Maximizing the Ribbon When the Ribbon is minimized, you can make it reappear by clicking a tab.
However, the Ribbon will disappear again when not in use. Backstage view Backstage view gives you various
options for managing accounts, saving and printing items like an email message or calendar , and more.
Although it is similar to the File Menu from earlier versions of Outlook, Backstage view will expand to fill the
entire screen, unlike a traditional menu. The options in Backstage view will change depending on which view
you have selected. To access Backstage view: Click the File tab on the Ribbon. Backstage view will appear.
Clicking the File tab Click the buttons in the interactive below to learn more about using Backstage view.
Save As Click Save As to save the currently selected item such as an email message or a calendar to another
location on your computer. Help From here, you can access Microsoft support and check for updates. Info Info
displays basic information about your email account. From here, you can also modify your account settings,
set a vacation reply, and more. Open From here, you can open a calendar from another application, open an
Outlook Data file, or import contacts, settings, and RSS feeds. Options Options gives you access to advanced
settings in Outlook, like adding an email signature, calendar preferences, and more. Return to Outlook Click
any tab on the Ribbon to close Backstage view. The setup process will vary depending on how you plan to use
Outlook: Using Outlook with a personal email account While Outlook is most commonly used in the
workplace, there are several reasons you might want to use it at home. If you use more than one email
accountâ€”for example, one for personal email and one for work emailâ€”you can add multiple accounts to
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Outlook, allowing you to read and manage all of your messages at the same time. To add a personal email
account: Click the File tab to access Backstage view. Locate and select Add Account below Account
Information. Adding a new account The Add New Account dialog box will appear. Enter your name, email
address, and password, then click Next. Adding account information and clicking Next Outlook will configure
the account. This process can take several minutes. Connecting with the email server Once the configuration is
complete, click Finish. Clicking Finish The email account will be added to Outlook. The added email account
The first time you open Outlook on your home computer, the Add New Account dialog box will appear
immediately. Follow the instructions in the procedure above to add your personal email account. Adding a
Gmail account will not import other Google services, such as your Gmail contacts or Google Calendar. Open
Outlook on your computer. Try switching between different views. Click through the tabs and notice how the
commands on the Ribbon change. Minimize and maximize the Ribbon.
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2: Free Outlook Tutorial at GCFGlobal
A short and sweet training for Microsoft Outlook - the basics!

Then they will learn how to manage e-mail messages and attachments, configure message options, and use
search folders. Students will also learn to manage contacts and use the People Pane, work with tasks, and
create appointments. Finally, they will learn to send and respond to meeting requests. Please note that this
course in not appropriate for those students using Mac computers running the Mac version of Microsoft
Office. Student materials will be shipped to the address provided upon registration. Make sure that the
additional info field is properly and correctly filled out to avoid materials being lost in transit. Please also note
that P. Box addresses are not allowed. This course in not appropriate for those students using Mac computers
running the Mac version of the software. This course is only appropriate for those using PCs running the
Windows version of the software. Our instructors teach from a remote location while being able to interact
with students as in a traditional classroom setting. Instructors can view student progress and take control of
their PC to provide direct assistance. You can cancel or reschedule your registration without penalty or charge
provided you give notice of 10 business days M-F or more days before the start of my class. You have one 1
opportunity to use our Make-Up policy to have those funds applied to a later class date. You cannot change
your class location ten 10 Business days M-F or less before the class start because Certified Staffing Solutions
has shipped training materials and provisioned resources. Location changes requested prior to that timeframe
are subject to availability and may incur an additional charge. Should Certified Staffing Solutions need to
cancel your class due to insufficient enrollment, or postpone it due to events beyond their control, Certified
Staffing Solutions will notify you as soon as possible. In such cases, you may reschedule to a future class date
at no additional charge or receive a refund for any money on account relating to that registration. Travel
arrangements and costs are the sole responsibility of the student. Certified Staffing Solutions suggests
obtaining refundable reservations. Certified Staffing Solutions classes are confirmed approximately 14 days
before the start of the class. We cannot guarantee class commitments before that window of time.
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3: Outlook for Windows training - Office Support
MicrosoftOutlook Â® Quick Reference Card The Outlook Screen Navigation Pane zas Contains mail-related folders like
your Inbox, Sent Items, and Search Folders.

Contains mail related folders like inbox and sent items folder. Use the Favorites section at the top of the pane
for easy access to frequently used folders Calendar â€” Lets you view and schedule appoints, events and
meetings, and compare calendars side by side. Tasks â€” Organize to-do lists, track task progress and delegate
tasks. Contacts â€” Store addresses, phone numbers, and e-mail addresses. E-mail Basics E-mail Basics: View
Tab Changing view of Reading Pane You can change the view of your Reading Pane on the screen, moving it
to the right or bottom of the screen. You can also turn it on an off. Click the View Tab. Click Reading Pane in
the Layout section of the Ribbon. Click Right, Bottom or Off. You can also turn the Navigation Pane off.
Click Navigation Pane in the lay out section of the Ribbon. Click Normal, Minimized or Off. You can also
choose whether you want the favorites folders to show. You can select which features of the To-Do Bar are
visible and choose between Normal and Minimized views. You can also turn the To-Do Bar off. Click New
E-mail in the New section of the Ribbon. The new e-mail window will open. Type the address of the recipient
in the To Type an address in the Ccâ€¦ field if you wish to send a copy of the message to a third party. Type a
subject matter in the Subject field. Type your message in the large text box. Auto-complete appears as soon as
you start typing an address in the Toâ€¦ field. Hit enter on your keyboard when the correct address is displayed
and auto-complete will fill in the remaining characters. It can help you find contact information and e-mail
addresses, and can be accessed from the new e-mail window. We will discuss the Global Address List in
greater detail later in this guide. Type an identifying piece of information, such as a last name, into the Toâ€¦
field. On your keyboard, hold the Ctrl key down and hit the K key. The Check Names window will open. This
window lists all matches from both your personal contacts and the Global Address List. Click the record for
the person you want to message. An e-mail address for the person you want to message will appear in the
Toâ€¦ field. Working with Folders Folders provide a useful way to manage your messages. They appear in the
navigation pane. You can create folders in any structure that suits your needs. Right click on the folder that
will house your new folder. Click New Folder in the drop down menu. The Create New Folder window will
open. Type the name of your new folder in the Name field. Click in the Select where to place this folder field
if you wish to change where your folder will be located. The new folder will appear in the location you
indicated. You can drag and drop messages directly to this or any folder. Signatures Creating a Signature
Outlook allows you to create custom signatures for your messages. You may create multiple signatures to
apply to messages as you see fit. Your first signature is automatically applied as your default signature and
will appear on your outgoing messages. Click the Home Tab if necessary. Click Signature in the New E-Mail
menu. Click Signaturesâ€¦ in the drop down menu. The Signatures and Stationary window will open. Click
New to create a new signature. Type the name of your signature in the New Signature window that appears.
Type your desired signature in the text box below. Click Save to save your signature. Add additional
signatures or Click OK to exit. Inserting a Signature If you have created more than one signature, you can
select which one you wish to use while composing a new message. Open the New E-Mail window. Click
Signature in the New E-Mail ribbon. A list of the signatures you have created will appear in the drop down
menu. Click on the signature you wish to use. The signature will appear in at the bottom of your message.
Rules Click on Rules in the Ribbon. This opens the Rules Wizard window. Select the type of rule you wish to
create in the Step 1: Select a template menu. In this example, select Move messages from someone to a folder
and Click Next. Click the check box next to the condition s you wish to trigger the rule. In this example, click
from people or public group. Click the people or public group link in Step 2: Edit the rule description to open
the Global Address List and select a person or group to whom the rule applies. Click the specified link in Step
2: Edit the rule description to open a list of your folders. Select the folder to which you want to move
incoming messages and click OK. Your selections will appear in the Step 2 window. Verify that they are
correct and Click Next. Click what action you want Outlook to take with the messages. In this case, click
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move it to the specified folder and click Next. Select any exceptions you wish to apply to the rule. In this
example we are not adding any exceptions. Click Finish to complete the wizard and apply your new rule.
Calendar Basics Outlook has a robust calendar feature for managing your time and scheduling meetings with
other NU users. The calendar will appear in the Outlook Screen. Adding an Appointment There are two ways
to add an appointment to your calendar: Click New Appointment in the Ribbon. OR Double click an area on
your calendar. The Appointment window will open. Type a subject for your appointment in the Subject field.
Type a location for your appointment in the Location field. Set a start and end date and time for your
appointment. Type a note for your appointment in the large text box. Click in the Reminder field in the ribbon
to set a reminder for your appointment. Reminders can be scheduled for five minutes to two weeks before the
appointment. Your appointment will appear in your calendar. Adding a Meeting Request Meetings differ from
appointments in that a meeting allows you to invite attendees and reserve rooms and resources at
Northwestern. When you create a meeting request, invited users will receive an e-mail invitation to which they
can respond. You will receive notification when users accept, decline or propose a new time for the meeting.
There are two ways to access the New Meeting window. Click Meeting in the drop down menu. The New
Meeting window will open. Type a subject for your meeting in the Subject field.
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4: Outlook Basic Training: Information Technology - Northwestern University
Microsoft Outlook offers premium business and personal e-mail management tools to more than million Microsoft Office
users worldwide. With the release of Outlook , you get a richer set of experiences to meet your communication needs at
work, home, and school.

The name of the tab depends on whether the message is selected in the message list or opened in its own
window. To add a recipient, click in the To, Cc or Bcc box and enter the recipient. Top of Page Add an
attachment to an e-mail message Files can be attached to an e-mail message. Also, other Outlook items, such
as messages, contacts, or tasks can be included with messages that you send. Create a message, or for an
existing message, click Reply, Reply All, or Forward. In the message window, on the Message tab, in the
Include group, click Attach File. Top of Page Open or save an e-mail message attachment You can open an
attachment from the Reading Pane, or from an open message. After opening and viewing an attachment, you
may choose to save it to a disk drive. If a message has more than one attachment, you can save multiple
attachments as a group or one at a time. Open an attachment Save an attachment Click the attachment in the
Reading Pane or the open message. On the Attachments tab, in the Actions group, click Save As. You can also
right-click the attachment, and then click Save As. Top of Page Add an e-mail signature to messages You can
create personalized signatures for your e-mail messages that include text, images, your Electronic Business
Card, a logo, or even an image of your handwritten signature. Create a signature Open a new message. On the
Message tab, in the Include group, click Signature, and then click Signatures. On the E-mail Signature tab,
click New. Add a signature In a new message, on the Message tab, in the Include group, click Signature, and
then click the signature that you want. Top of Page Create a calendar appointment Appointments are activities
that you schedule in your calendar that do not involve inviting other people or reserving resources.
Alternately, you can right-click a time block in your calendar grid, and then click New Appointment. Top of
Page Schedule a meeting with other people A meeting is an appointment that includes other people and can
include resources such as conference rooms. Responses to your meeting requests appear in your Inbox.
5: Microsoft Outlook Basic
Outlook Basic Training Page 2 of 21 The Outlook Screen. Navigation Pane. Mail Contains mail related folders like inbox
and sent items folder. Use the.

6: Outlook Basic - Outlook Training New York | CourseHorse - Certstaffix Training
In Outlook Essential Training, author Karen Fredricks provides in-depth instruction on the key features of Outlook The
course shows how to master fundamental Outlook features including sending and receiving email, creating an address
book, and scheduling activities and tasks.

7: Outlook Getting to Know Outlook
Outlook Training Course Description Boost your communication skills and increase your productivity in the workplace
and beyond using CustomGuide's Microsoft Outlook course.

8: Basic tasks in Outlook - Outlook
In this free Outlook tutorial, learn how to create and maintain an account using this popular email software.

9: Outlook Basic - Free download and software reviews - CNET www.enganchecubano.com
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Find training courses for Outlook. Thank you for your feedback! It sounds like it might be helpful to connect you to one of
our Office support agents.
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